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1  Introduction to STS Telemetry and Leveloggers

Solinst STS Telemetry Systems provide an economical and efficient method to
access remote data instantly.  They provide two-way communication between field
located dataloggers and a Home Station computer.  

STS Gold Telemetry Systems are designed specifically for the high quality
Levelogger series of dataloggers.  Up to four Solinst dataloggers can be connected
to one STS Remote Station, in any combination of the Levelogger Gold,
Levelogger Junior, Barologger, or Rainlogger.  

STS Systems operate on two basic schedules.  A linear “Sample Rate” is set, at
which the STS Controller at the Remote Station records a real-time reading from
each attached datalogger.  A “Report Rate” is set to establish the frequency 
that the data is sent from the Remote Station to the Home Station Computer.
Optionally, dataloggers themselves can be set up to record and store data
independently of the STS System. This provides a reliable back-up if
circumstances require it.

STS Systems can be set up using CDMA or GSM digital cellular, or radio
communications. Using digital CDMA or GSM, the data is ‘pushed’ from the
Remote Station to the Home Station using IP (Internet Protocol), and therefore,
dial-up or timing issues are not a problem.  The STS Controller stores data in its
memory until it has been successfully uploaded by the Home Station computer.

STS Telemetry Systems come with standardized hardware options, and STS Gold
Software which allows easy setup, operation, and management of data.  Features
such as alarm notification, remote diagnostic reporting and firmware updating
make it easy to maintain your system, while simplifying data collection.

This manual focuses on configuration, programming, and installation of STS Gold
Telemetry Systems using CDMA, GSM, and radio communications.  It also
discusses the various options to power the Systems.  It includes instructions for
installing and using STS Gold Software to set up data collection schedules,
manage data, perform remote diagnostic checks, and firmware updates.  Also
provided are References, a Glossary, and Appendices where various technical
specifications are shown.

RReemmoottee  SSttaattiioonn HHoommee  SSttaattiioonn  PPCC
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Levelogger Gold Technical Specifications
Level Sensor: Piezoresistive Silicon in 316L Stainless Steel

Accuracy (Typical): 0.05% FS

Stability of Readings: Superior, low noise, 6 times better than previously
Resolution: 0.002 to 0.0006% FS

Normalization: Automatic Temp Compensation

Temperature Sensor: Platinum Resistance Temperature Detector

Temp. Sensor Accuracy: ± 0.05°C

Temp. Sensor Resolution: 0.003°C

Temp. Comp. Range: -10 to +40°C

Battery Life: 10 Years - based on one reading/min

Clock Accuracy: ± 1 minute/year

Operating Temperature: -20°C to 80°C

Maximum # Readings: 40,000 of level and temperature

Memory: Superior reliability EEPROM Slate, rollover 
and redundant backup of last 1200 readings

Communication: Optical Infra-Red Interface, Serial at 9600 Baud,
Conversion  to RS232 or USB Computer Connection 

Size: 7/8" x 6" (22 mm x 154 mm)

Weight: 6.3 oz (179 grams)

Backwards Compatibility: Full

Corrosion Resistance: Zirconium Nitride (ZrN) Coating

Other Wetted Materials: 316-L Stainless Steel, Delrin, Viton

Sampling Modes: Linear, Event and User-Selectable with 
30 separate line items

Measurement Rates: 0.5 sec to 99 hrs

Barometric Compensation: Software Wizard and one Barologger in local area 
(approx. 20 miles/30 km radius and or per 1000 ft/300 m
change in elevation)

LT Models Full Scale
(FS)

Accuracy
(typical)

Resolution

F15, M5 16.4 ft., 5 m ± 0.010 ft., 0.3 cm 0.001% FS

F30, M10 32.8 ft., 10 m ± 0.016 ft., 0.5 cm 0.0006% FS

F60, M20 65.6 ft., 20 m ± 0.032 ft., 1 cm 0.0006% FS

F100, M30 98.4 ft., 30 m ± 0.064 ft., 1.5 cm 0.0006% FS

F300, M100 328.1 ft., 100 m ± 0.164 ft., 5 cm 0.0006% FS

FFiigguurree  11--11  LLeevveellooggggeerr  GGoolldd

TTaabbllee  11--11

Levelogger Gold

The Levelogger Gold is an absolute (non-vented) dataloggers, which measures
total pressure and temperature and is ideal for monitoring groundwater and
surface water.  Water levels are displayed as temperature compensated pressure
readings and can be barometrically compensated with the aid of a Barologger
Gold.
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Levelogger Junior

The Levelogger Junior provides a low cost alternative for measuring
groundwater and surface water levels and temperature.  The Levelogger Junior
is compatible with all Levelogger Gold accessories. 

3001 Junior Technical Specifications
Level Sensor: Piezoresistive Silicon in 316L SS

Ranges: F15/M5, F30/M10

Accuracy (typical): 0.1% FS

Resolution: 0.028%, 0.021%

Normalization: Automatic Temp Compensation

Temperature Sensor: Platinum RTD

Accuracy: ± 0.1˚C

Resolution: 0.1˚C

Temp Compensation Range: - 10˚C to 40˚C

Battery life: 5 Years

Clock Accuracy: ± 1 minute/year

Operating Temperature: - 20˚C to 80˚C

Memory: Non-volatile EEPROM, FRAM back-up

Maximum # Readings 32,000 sets of readings

Communication: Optical Infra-Red to USB or RS232

Size: 7/8” x 5.5” (22 mm x 140 mm)

Weight: 154 g (5.4 oz)

Wetted Materials: 316L Stainless Steel, Delrin®, Viton®

Sampling Mode: Linear, SDI-12, Real Time View

(from 0.5 sec to 99 hrs)
Barometric Compensation: Software Wizard and one Barologger in local area 

(approx. 20 miles/30 km radius and or per 1000 ft/300 m
change in elevation)

TTaabbllee  11--33

FFiigguurree  11--33  LLeevveellooggggeerr  JJuunniioorr

Junior Models Full Scale
(FS)

Accuracy
(typical) Resolution

F15, M5 16.4 ft., 5 m ± 0.020 ft., 0.6 cm 0.028% FS

F30, M10 32.8 ft., 10 m ± 0.032 ft., 1.0 cm 0.021% FS

Barologger Gold

The Barologger Gold uses algorithms based on air pressure only.  It measures
and logs changes in atmospheric pressure, which are then used to compensate
water level readings recorded by a Levelogger Gold, or a Levelogger Junior.

Models Full Scale
(FS)

Water Fluctuation
Range

Accuracy
(typical)

Resolution

Barologger 0.05% Air Only ± 0.003 ft., 0.1 cm 0.002% FS

FFiigguurree  11--22  BBaarroollooggggeerr  

TTaabbllee  11--22

Note:
Only one Barologger
is required for a 
20 mile (30 km)
radius, as long as

elevation differences are within
1000 ft. or 300 m.
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Rainlogger

The Rainlogger is designed for use with most standard tipping-bucket rain
gauges with a reed switch output.  It measures total rainfall per sampling period
and a five-minute maximum rainfall (intensity).  Users can add rainfall data to
their Levelogger network.  

Rainlogger Technical Specifications

Battery Life: 10 years (logging two parameters/10 minutes)

Clock Accuracy: ± 1 minute/year

Operating Temperature: -20˚C to 80˚C

Resolution: 0.004 to 0.008" (0.1 to 0.2 mm) (dependent on rain gauge type)

Maximum # Readings: 40,000 sets of readings

Memory: Non-volatile EEPROM / FRAM back-up

Communication: Optical infra-red to RS232 or USB

Sampling Mode: Linear

Sampling Rate: 5 minutes to 99 hours

Size: 7/8" x 7" (22 mm x 175 mm)

Weight: 4.8 oz (135 grams)

Materials: Stainless Steel, Delrin®, Lexan, Viton®

FFiigguurree  11--44  RRaaiinnllooggggeerr

TTaabbllee  11--44

STS Gold Telemetry User Guide
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1.1  Level

The Levelogger Gold and Levelogger Junior use a high quality piezoresistive silicon
pressure transducer packaged in a 316L stainless steel housing.  It gives high accuracy
and high stability. The Levelogger Gold body is coated with Zirconium Nitride (ZrN) to
give corrosion resistance.  All Leveloggers measure total or absolute pressure. When
the Levelogger is operating in open air, it is recording barometric pressure and
converting that pressure reading to its water level equivalent above the datalogger’s
pressure zero point of 950 cm (31.17 ft). When submerged, it is recording the
combination of barometric pressure and water pressure. The Levelogger converts the
total pressure reading to its corresponding water level equivalent. Actual water level is
obtained by compensating for barometric pressure. The best method to compensate
for barometric pressure is to employ a Barologger above the water level, somewhere
on site, to obtain records of barometric pressure.  Although the STS Software does not
support this, the Levelogger Software includes a Barometric Compensation Wizard,
which guides the user through the automated process of barometric compensation.
Manual methods can be employed to determine the absolute water level using
barometric records collected on-site or available from a local weather station 
(i.e. Airport). Water level readings from the Levelogger Gold and Levelogger Junior
models are temperature-compensated.

1.1.1  Pressure Calibration

The Levelogger Gold and Levelogger Junior are calibrated against a range of set
reference points to an accuracy of 3 decimal places. The units of pressure are in
pounds per square inch.  The conversion factor for pounds per square inch relates to
pressure as follows: 

1 pound per square inch = 0.0689476 bar 
= 703.070 Kg/m2

= 6.895 kPa 
= 2.31 ft.  H20 @ 4°C.

During the calibration procedure, the Levelogger is fully submerged in a highly
accurate water bath. The bath is set to 15°C and allowed to stabilize. 
The pressure is then calibrated to six separate pressure points covering the
entire range of pressure for that particular Levelogger to check for any 
non-linearity. The process is repeated again at 35°C to check for temperature
effects. Once complete, the Levelogger is only approved after all specifications
for accuracy, precision, stability, and hysteresis have been met.

1.2 Barologger

The Barologger Gold is designed for use in air only.  It has a specific range and
firmware algorithms based on air pressure rather than water pressure.  This makes the
Barologger less accurate if used in water, but more accurate if used as intended, in air.
Using a Barologger is the most accurate and convenient method of obtaining
atmospheric pressure.  When programmed with the same sampling parameters as the
Leveloggers on site, a Barologger can avoid barometric data time lags and any errors
introduced due to moisture buildup, kinking, or damage to vented cables. 
The Barometric Compensation Wizard in the Levelogger Software simplifies the
adjustment of the level measurements for barometric pressure changes, by using the
synchronized data from all Leveloggers on site and the site Barologger. 

Note: 
STS Software does
not include a
Barometric
Compensation

Wizard.  STS data files can be
exported for use in Levelogger
Software, which has an
automated compensation process.
Exporting STS data and
barometric compensation is
discussed in Section 7.

FFiigguurree  11--55  LLeevveellooggggeerr
aanndd  BBaarroollooggggeerr  iinn  WWeellll



STS Gold Telemetry User Guide

Page 9

1.3  Temperature

Levelogger Gold and Levelogger Junior, record temperature compensated water
levels.  Groundwater and surface water temperature measurements are
particularly important in situations where temperatures may fluctuate
significantly, and when temperature is used in determining liquid level, viscosity,
and hydraulic conductivity. Temperature monitoring is vital in the calculation of
certain temperature dependent contaminant reaction rates. A Platinum
Resistance Temperature Detector is used to accurately compensate for
temperature changes within the range of -10 to +40˚C.  The Leveloggers will
record temperature in its thermal range of -20 to +80˚C, but outside the range
of -10 to +40˚C compensation will be less accurate. 

1.4  Total Rainfall

The Solinst Rainlogger is designed to count the tips of an external tipping-bucket rain
gauge within a user defined sample interval and output the total rainfall over that
sample interval. The Rainlogger can store 40,000 sets of readings. The Rainlogger is
designed to be compatible with the Solinst Levelogger series of products.
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2  STS Gold Software
The Home Station computer requires STS Gold Software.  The software
provides an easy-to-use graphical interface to set up remote sites, specify
communication intervals, define sampling rates for attached dataloggers,
determine alarm settings, and perform remote diagnostic tests and remote
firmware updates.  Collected data is stored and viewed using the software; it can
also be exported for use in other programs.  

2.1 System Requirements

The minimal hardware and software requirements for software installation
and operation are:

Software

Hardware Software

Memory: 256MB or more OS: Windows 98, ME, 2000 or XP

Display: VGA: 800 x600 pixels, 256 colour

Ports: RS232 Serial Port and/or Internet
connection with IP address

Hard Drive space: 64MB

TTaabbllee  22--11

Note: 
The STS Gold
Software should
always remain open
when the STS System

is in operation.  It may be closed,
but the data can not be sent to
the Home Station Computer.
The data will be stored in the STS
Controller until the software is
re-opened, and not until the next

scheduled report .

Note: 
You must have
administrator
privileges on your PC
to install STS
Software.

2.2 Software Installation

Place the STS Gold CD in the CD ROM drive or download the software from
www.solinst.com/Downloads/ and save to hard drive.

1) Open Windows Explorer and double-click the setup.exe icon.

2) At this point Windows will prompt you through the remainder of the
installation process. 

3) Restart the computer after installation is completed. Default Directory is
<C:\Program Files\Solinst\STS_Gold>
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3  Home Station Configuration

To Start the STS Software, click on icon, or click the Start button and
select:

Programs > Solinst > STS_Gold > STS_Gold_Admin

3.1 STS Administrator

After the STS Software has been started, the STS Administrator screen will
open.  From here, you can create new STS sites, edit existing sites, delete
existing sites, and open site data.

The Menu on the left of the screen lists each existing STS Site by their Serial
Number (number located on the STS Controller).  Selecting a site from the list
will display information on the sites Remote Station Battery Strength, Remote
Station Signal Strength, Last Update Time, and site details (including Project ID,
Location, Number of Loggers, etc).  Information for each datalogger  connected
to the site is displayed, including instrument type, and battery strength.  

• Last Update Time, shows the last time the Remote Station contacted
the Home Station.

• Remote Station Battery, percentage of strength left in the Remote
Station battery.  

• Remote Station Signal Strength,  signal strength of the modem at
the Remote Station. 

FFiigguurree  33--11  SSTTSS  AAddmmiinniissttrraattoorr  SSccrreeeenn

Note: 
The alarm clock icon
shown beside a
datalogger on the
Administrator Screen

indicates that an alarm condition
has been set for this datalogger.
It does not mean an alarm
condition has been met.
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3.2 Create New Site

Selecting opens the STS Information screen.  It will also
open when the software first starts.  This is where you set up each site in your
Telemetry network.

In this screen you will enter the Serial Number of the STS Controller, the unique
name you choose to identify the site (Project ID), the Location of the site, and
it allows you to set a start date and time to begin data collection.  You can also
restart data logging at a specific time if you have stopped the system previously.

• Project ID, input your own identification system. 

• Location, input specific site / location information.

In the middle section of the screen, you will select whether you are using Radio
or IP Modem as your communication method, and either a GSM or CDMA
modem.

FFiigguurree  33--22  SSTTSS  SSttaattiioonn  IInnffoorrmmaattiioonn  SSccrreeeenn

• Always On, indicates that the Remote Station has been set to be always
on or not.

• Project ID, your own identification system that you input. 

• Location, specific site / location information you input.

• Number of Loggers, the number of dataloggers that are programmed
to be connected to the Remote Station.

• Comm Method, indicates that the site is using either IP modem or radio
communication.

• Sampling Information, shows the rate the STS Controller is polling
the field located dataloggers for readings.

• Site Status, will show the status of the STS Controller at the Remote
Station, i.e.  “Logging”, “Waiting for Update”.
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You will also program your Data Collection Schedule.  A Sample Rate and
Report Rate is selected.  

• Sample Rate is the rate the STS Controller collects a real-time reading
from the attached dataloggers.  Sample Rate can be set from 10 seconds
to 99 hours. 

• Report Rate is the rate at which stored data is sent from the STS
Controller to the Home Station computer.  With each report to the
Home Station, the Remote Station time and Home Station time are
synchronized, and battery and signal strength at the Remote Station is
sent along with the data collected from the dataloggers.  It can be set
from 1 minute to 1 week. 

If you select a Sample Rate of less than 10 minutes or a Report Rate less than
30 minutes, you will check Always On.  Checking this will ensure the STS
Remote Station is continuously running and the modem and STS Controller are
ready to collect and send data.  With less frequent Sample and Report Rates,
you do not need to check Always On.  The Remote Station will be idle between
data sampling and reporting to conserve battery power.  More frequent Sample
and Report Rates do not allow sufficient time for the modem to shut-down and
“wake-up” between data collection and send events.  

Radio Scheduling

If you select Radio as your communication method, the STS Station Information
Screen will expand to include the Radio Schedule section.  This section allows
you to configure a  Report Rate and a Report Duration  for your Radio Remote
Stations.  This is important if multiple Radio Remote Stations will be reporting
to one Home Station Computer.  Setting up a schedule will avoid conflicts that
may occur if more than one Remote Station contacts the Home Station at the
same time (see Figure 3-3).

Note:
If you choose a
Sample Rate less than
10 minutes or a
Report Rate less than

30 minutes, you will need to
make sure you select your STS
site to be Always On.  The
system will not “initialize”, if you
do not select this when required.
By selecting Always On, you will
be using Remote Station power
continuously.  Ensure you have
sufficient power supply. 

Note:
If you choose to set
your System to
Always On, the
standard 12V battery

will last less than 2 days, before
recharging is required.  See
Section 6.1 for a discussion of
optional power sources and
external recharging accessories.

FFiigguurree  33--33  SSTTSS  SSttaattiioonn  IInnffoorrmmaattiioonn  SSccrreeeenn  aanndd  RRaaddiioo  SScchheedduulliinngg
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After all STS Information is entered, select Next to open the Levelogger Setup
window.

Example: If you have three Radio Remote Stations reporting to one
Home Station Computer, all with a Report Rate of 15 minutes, you will
want to set a Report Duration of 5 minutes (or less) for each Remote
Station.  This ensures that each Remote Station has enough time to
send the data within the 15 minutes allotted on the Home Station.

• Report Duration is the span of time that a Radio Remote Station will
be in contact with the Home Station during the transfer of data from the
STS Controller.   

• Report Rate is the rate at which stored data is sent from the 
STS Controller to the Home Station computer.You will also select which
communication port your radio is connected to at the Home Station.

Note: 
An error will occur if
the Report Duration is
a longer time span
than the Report Rate.
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The Levelogger Setup window allows you to enter the type of datalogger that will be
connected to each of the four positions on the STS Distribution Box.  After selecting
the datalogger type from the drop down menu, an image of the selected datalogger
will be displayed.  

If there are not four dataloggers connected, select “NONE” from the drop-down menu
for each of the positions on the Distribution Box with no datalogger connected.
Initialization will not be successful if a datalogger type is selected, but is not physically
attached to the Distribution Box.

Select Edit to begin entering data collection information for the datalogger.

FFiigguurree  33--44  LLeevveellooggggeerr  SSeettuupp  WWiinnddooww

3.3 Assigning Dataloggers to Remote Station

Note:
Dataloggers can be
programmed using
the STS Software to
record and store

readings in their internal, non-
volatile memory providing
reliable back-up data.  This will
cause their internal battery to be
used up more quickly 
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3.3.1 Levelogger Information Settings

The Levelogger Information window includes Levelogger Serial Number, Well
Location, Altitude, Density Adjustment, Sample Rate, and Memory Mode
Selection. 

If you want your datalogger to record and store readings in its internal memory,
independent of STS operation, select , and fill in the Sample Rate and
Memory Mode Selection fields.  The Rainlogger must be set in this mode.  

If you do not require independent logging, select , and the STS Controller
will only collect a real-time reading from the Levelogger at the scheduled STS
Sample Rate.  There is no need to enter a Levelogger Sample Rate. 

• Serial Number, your Levelogger Serial Number will display after
the System is initialized.

• Well Location, input specific site / location information.

Note: If you want
your datalogger to
record and store
readings in its internal
memory, independent
of STS operation,

select

FFiigguurree  33--55  LLeevveellooggggeerr  IInnffoorrmmaattiioonn  WWiinnddooww

Note:
To stop the
Levelogger from
independently
logging, 

select

Note:
The Rainlogger must
be set to record
independently with a
Sample Rate.  It will
not take real-time
readings.

Note:
The Levelogger’s
serial number will
auto-fill once the
system is initialized.
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• Density Adjustment is used to adjust the range of the Levelogger based
on the sample fluid density.  The range for the density adjustment is from
0.9 kg/L to 1.1 kg/L.  Uncheck the Density Adjustment field to
disable the Density Adjustment function.

• Altitude in feet or meters above sea level, at which the logger is actually
deployed, is input in the altitude field.  Water column equivalent pressure
decreases with altitude at a rate of approximately 1.2:1000 in the lower
atmosphere below 5000 m.  You can compensate for this by entering 
an elevation between -1000 ft below sea level and 16,400 ft 
(or -300 m and 5000 m) above sea level. The readings will then be
automatically compensated for elevation.

• Sample Rate, is linear.  Linear refers to a set time interval between
collection of readings. Sample Rate can be any number from 0.5
seconds to 99 hours. The Rainlogger can be set to sample from 5
minutes to 99 hours.  The time unit and number of time unit intervals
between each reading are set up in the Sample rate fields. The
Levelogger Gold and Barologger Gold can store 40,000 readings of level
and temperature. The Levelogger Junior can store 32,000 readings.  The
Rainlogger can store 40,000 sets of rainfall level and 5 minute peak
intensity readings.  

• Memory Mode Selection, there is a choice of Continuous Logging
(wrap around) or Slate Logging.  In Continuous Logging the new log is
started at the end of any previous log and continues logging, eventually
recording over the first logged data.  As one of the download options is
to ‘Append Data’, Continuous Logging can be a preferred choice when
logging long-term.  In Slate Logging the new log is also started at the end
of any previous log, but will stop recording after 40,000 readings, so that
the beginning of the current log will not be written over.

Note: 
Sample Rate for the
Rainlogger can only
be set from 5 minutes
to 99 hours.

Note: 
In Slate Logging, the
datalogger will stop
recording readings
after its memory is

full.  Therefore, Continuous
Logging is recommended for long
term monitoring applications.

Note:
The default Sample
Rate is set to 
15 minutes
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3.3.2  Setting Up Levelogger Measurement Parameters

In the lower portion of the Levelogger Information screen is the window for
setting channel parameters. The software will detect the available channels
when the Levelogger Information settings are read.

For the Level Channel, you can set the following parameters:

• Identification describes the measurement parameter of the channel and
has already been configured as ‘level’.  The Level Channel monitors
water column equivalent pressure.  The Identification field will be the
data column heading and graph line name when viewing the data.  

• Units refers to the channel’s units of measurement. There are three units
of measure available for the user to select: cm, m or ft.  When the user
changes the unit, the value of the range and altitude will change
according to the Unit Conversion formula.  Note that when a metric unit
is used, the unit of altitude is meters. When feet are the Level Channel
units, feet are the units of altitude.

• Offset refers to an offset correction, such as the distance between the tip
of the Levelogger and the monitoring well cap or static water level.  It is
recommended that the value of 0.00 be used for offset as this keeps all
subsequent readings relative to the tip of the Levelogger. The offset
range for Levelogger Gold, the Levelogger Junior and Barologger Gold
units is -1000 to 16400 ft or -300 m to 5000 m. 

The Temperature Channel includes the following parameters: 

• Identification, and Units
• The Temperature Channel has been pre-configured by Solinst in °C and

cannot be changed.

Note: 
Readings can be
corrected or offset
with respect to a
specific reference

elevation or datum for a much
wider spectrum of numeric
Offsets as part of the Data
Compensation Wizard in the
Levelogger Software.

FFiigguurree  33--66  TTeemmppeerraattuurree  CChhaannnneell
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Rainlogger Measurement Parameters

The RainFall Channel will provide the total rainfall depth within the sample
interval. It does so by multiplying the number of tips within the interval by the
tipping bucket's calibration factor. The calibration factor is the amount of
rainfall depth (mm, in) per tip. The calibration factor should be indicated on a
label on the tipping bucket device or in the manufacturer's documentation.
Input the calibration factor in mm or inches in the Rainfall Calibration
Constant field.

The MaxRainFall Channel does not require any setup or user input. The
readings in Channel 2 are of maximum 5 minute peak intensity within the
sampling interval. This rainfall intensity value is derived by subdividing the
sample interval into 5 minute sub-intervals and temporarily recording the
number of tips in each 5 minute sub-interval. The Peak intensity reading is
calculated by multiplying the number of tips in the 5 minute interval with the
largest number of tips by 12 and presenting peak intensity/hr. 

FFiigguurree  33--77  RRaaiinnllooggggeerr  SSeettttiinnggss

After filling out the required fields, click Save Settings to apply the information.
The Levelogger Setup window will again be shown.  

Continue entering information for each of the attached Leveloggers.  When
each logger has been programmed, click Next on the Levelogger Setup window.
The Alarms Setup window will open.
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3.4 Setting Up Alarms

The Alarm Setup window allows you to set specific alarm conditions for each
of the attached dataloggers.  

For each channel parameter (level, temperature, rainfall level) you can set a
“High Limit”, “Low Limit”, and “% Change” alarm.  The “High Limit” sets a
value, that if exceeded by a Levelogger reading, will result in an alarm condition
being met.  The “Low Limit” alarm condition is met when a reading taken by
the datalogger goes below the set value.  A “% Change” alarm condition is met
when a reading taken by the datalogger changes by the set percentage, from
the last recorded reading. 

By entering a value in the “for__times” field, you can set how many consecutive
readings, which meet an alarm condition, must be met before an actual email
notification is sent.  If set as 1, you will be notified the first time an alarm
condition occurs.

FFiigguurree  33--88  AAllaarrmm  SSeettuupp  SSccrreeeenn

Note: 
Ten is the maximum
number of alarm
notifications that can
be sent to your email
address after an alarm
condition is met.

Note: 
Alarm messages will be
sent when the battery
at the Remote Station
drops below  9 Volts,

only if you set up an e-mail to
receive alarms messages. (See
Figure 3-8).

Note: 
The value entered in
the “for__times” field
sets the number of
times an alarm

condition is met for a parameter,
before an email is sent.  Example,
if you input 3, then only on the
third time that the alarm
condition is met, will an e-mail be
sent.

Note: 
The frequency that
alarm conditions can
be reported is based
on the Sampling Rate
set for the Remote
Station.
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In the bottom section of the window you enter an email address to receive
messages if an alarm condition is met.  An SMTP (Simple Mail Transfer
Protocol) must be set up.  Click Setup to do this.  The  outgoing mail SMTP
server used by the Home Station Computer will have to be entered to enable an
alarm message to be sent to the desired email address.  You will enter the email
address you want alarm messages sent to, and your user name and password.
Click ‘OK’ when finished.

By entering your email, you will also receive alarm messages when the Remote
Station Battery goes below 9 Volts.   

FFiigguurree  33--99  SSMMTTPP  SSeettuupp

You will also set the maximum number of notifications to be sent to the address
after an alarm condition has been met, or until it has been reset in the software.
A maximum of 10 emails can be sent for one alarm condition.

Selecting Test ensures the address entered is correct, by sending a test message
to your email account.

After you have entered settings for each datalogger, as desired, click Finish.  The
STS Administrator screen will again be shown, with all of the entered
information shown for the STS Site.

Note: 
Contact your IT
Department if you do
not know your user
name, password, or

the SMTP Server your Home
Station Computer is using to send
an outgoing email. 

Note: 
Multiple email
addresses can be
notified of alarms by
entering each address,
separated by a
comma “,”.
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3.5 STS Communication Agent

The STS Communication Agent is included with the STS Gold Software
package.  The STS Communication Agent is an information window that will
display all communication activity that has occurred between a Remote Station
and the Home Station.  This application is used to view activity, and monitor
communication.  The serial number of each STS Remote Station will be shown
to indicate which communication has come from that site.  Each report will be
time and date stamped.  By clicking the Save icon, you can save the log file on
your Home Station computer for your record or for diagnostic purposes. 

The Communication Agent will also display the progress during a Remote
Firmware Upgrade (Section 8 discusses Remote Firmware Upgrades).

The Communication Agent will open automatically, when the STS Gold
Administrator has been started.  The Communication Agent can be left open,
and minimized even after the STS Gold Software Administrator has been
closed.  The STS Gold Communication Agent should always remain open
when the STS System is in operation, but if it is closed the log files can be
retrieved from the following location:

<C:\Program Files\Solinst\STS_Gold\log>

To open the STS Communication Agent, click , or click the Start button 
and select:

Programs > Solinst > STS_Gold > STS_Gold_Com

Note: 
The Communication
Agent should always
remain open while
your STS System is in
operation and during
initialization.  
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4  Home Station Hardware Setup

CDMA/GSM

When using a CDMA or GSM digital cellular modem for remote
communication, an Internet connection with a static IP address is required at the
Home Station computer (the Remote Station requires a dynamic IP address).
This is set up by your local service provider.

Radio

When a radio modem is used for remote communication, a second radio
modem and antenna are connected to the Home Station computer through the
RS-232 serial port.  Solinst supplies a DB9 cable and an AC/DC Adaptor to
connect a power source to the Home Station radio.  The radio must have the
same settings programmed as the radio used at the Remote Station.  See
Section 5.7 for setup instructions.



5 Remote Station Hardware Setup

STS Telemetry Systems come with standardized equipment configurations.  The
STS Controller, Distribution Box, 12 Volt sealed lead-acid battery, selected
modem with antenna (optional high gain antenna also available), and all of
armoured conduit, and 3 NPT weatherproof fittings.  Leveloggers, Direct Read
Cables and Reader Cables to be used with the System are purchased separately.
The following figures show standard setups and cables for Remote Stations
using GSM, CDMA, and radio modems.
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Note:
It is recommended to
check all equipment
when you receive it,
to ensure all cables
and components are
accounted for. 

It is also recommended you setup
the Remote Station in the office,
and initialize as a test before
installing in the field.

STS
Controller
(#108707)

STS
Distribution Box

(#108762)

GSM Modem
(#108862)

Battery
(#105720)

Antenna

Levelogger
Reader Cable

(#108854)

Armored Protective 
Conduit (#108892)

Battery Cable
(#108836)

Modem
Serial Cable
(#108832) or

(#106811)

Connection to
Distribution Box

MD8M
Controller Cable

(#108831)
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Connection to
Distribution Box

8 A SLO-BLO Fuse
(#107755)

9-Pin RS-232
Connection to Modem

+ve Battery Connection

-ve Battery Connection

Connection to
Distribution Box

Connections
to Modem

FFiigguurree  55--22
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(#108845)

The three Remote Station setups use the same cables to connect the STS
Controller, Battery, and Modem (Serial Cable) to the Distribution Box.  The
Modem Power Cables for each setup are different, and are shown in
Figures 5-2, 5-4, and 5-6.

Note: 
You will need a small
slot-head screwdriver
to connect the wires
to the GSM modem.

NEMA 4X
Enclosure
(#108827)

Note: 
The GSM Assembly
also comes with a
Null Modem Cable for
use during modem
set-up and activation.
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STS
Controller
(#108707)

STS
Distribution Box

(#108762)

CDMA Modem
(#108839)

Battery
(#105720)

Antenna
(#108852)

Levelogger
Reader Cable

(#108854)

Armored Protective 
Conduit (#108892)

Connection
to Distribution
Box

Connection
to Modem
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(#108843)
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(#108903)
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STS
Controller
(#108707)

STS
Distribution Box

(#108762)

Radio Modem
(#108895)

Battery
(#105720)

Antenna
(#108950)

Levelogger
Reader Cable

(#108854)

Armored Protective 
Conduit (#108892)

Connection to Modem

Connection to
Distribution Box

NEMA 4X
Enclosure
(#108827)

Radio Telemetry Systems require a Radio Home Station Assembly (#109051),
which contains a second radio (#108895), antenna (#108950), serial cable
(#106811) for connection to the Home Station Computer, and an AC/DC
power adaptor (#109056). 

NEMA 4X
Enclosure
(#108827)
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5.1 STS Controller

The STS Controller powers-up the Remote Station for initial set up and testing.
It collects, stores, and sends data from the remote dataloggers to the Home
Station computer.  The STS Controller is attached to the Distribution Box at the
labeled connection using the cable provided.

Up to 8MB of data is stored in the STS Controller’s non-volatile memory, until
a specified time when the Controller ‘sends’ the data to the Home Station,
where all the accumulated data is uploaded. If there are cellular service
disruptions, the STS Controller will store all the data internally until it has been
successfully uploaded to the Home Station computer.  

The STS Controller features a powerful 32-bit ARM processor, an LCD
interface and a five-button keypad to simplify in-field setup and data monitoring.
Stored data can be downloaded via USB or RS-232 ports to a laptop or
computer.  Firmware updates to the Controller can be uploaded from a laptop
or desktop PC using the USB port.  Remote firmware updates via the Home
Station computer to the Controller is also an option.

ControllerController

+1 (905) 873-2255

Made in Canada

12:30

STS Gold Menu

Status: IdleOK

Station Tests
STS Gold Setup
Initialize Home Station
PC Diagnostic
Modem Control

Power On

Confirm Selection

Scroll Up

Scroll Down
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12:30

STS Gold Menu

Status: IdleOK

Station Tests
STS Gold Setup
Initialize Home Station
PC Diagnostic
Modem Control

Figure 5-9 shows the main menu of the STS Controller. The top left icon
indicates the signal strength of the modem, the battery indicator shows the
strength remaining in the 12V battery, and the text in the bottom right corner
describes the status of the STS Controller. 

• Idle – indicates that the Controller is idle and waiting for initialization.

• Init – shows that the Controller is going through the initialization process
(initialization is discussed in Section 5).

• Logging – indicates that the Controller is collecting data from dataloggers.

• FUT. ST – indicates that the STS has been programmed with the future
start option.

There are five menu items on the STS Controller, which are scrolled through
using the arrows on the keypad and selected using the chevron button as
indicated on the screen:

• Station Tests – verify the connection with the Home Station, view real-
time readings from each of the attached dataloggers, and check the
battery voltage.

• STS Gold Setup – used to setup the STS Controller.  You can change
the contrast of the LCD screen and restore the original factory settings.
You can view STS Gold Information, including STS Firmware Version
and available memory. 

• Initialize Home Station – used to contact the Home Station and
initialize the STS System (this process is discussed in Section 5).

• PC Diagnostic – used to perform a diagnostic test on the STS Controller
through the serial port.

• Modem Control – used to turn the modem on or off.

See the STS Gold Remote Station Quick Start Guide, on the inside of the
STS NEMA 4X enclosure, for a complete view of all menu items.

FFiigguurree  55--99  SSTTSS CCoonnttrroolllleerr  MMaaiinn  MMeennuu
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5.2 Distribution Box

The STS Distribution Box has an independent 16-bit processor to monitor the
battery, control the modem power, perform Built-In-Test (BIT) functions and
select the Levelogger communication channels.  

The Distribution Box has labeled connections for the STS Controller, the
standard 12V sealed lead-acid battery, the modem and modem power.  The
two-wire connectors for four dataloggers are also clearly  indicated on the Box.
There are two other connections reserved for alternative power sources, these
options will be discussed in Section 6.1. 

There is a LED indicator on the bottom left of the Distribution Box. Under
normal operation, the LED will flash green every minute.  The LED will flash
red if a failure is detected.  The following are possible errors that may have
occurred:

1) The battery voltage is too low (i.e. < 9V).

2) The Distribution box fuse has blown. 

3) The internal regulator voltage is out of tolerance.

4) Program Memory test failed.

5) Electrically Erasable Programmable memory test fail.

FFiigguurree  55--1100  DDiissttrriibbuuttiioonn  BBooxx

Note:
To remove the
Reader Cable
connector pins from
the Distribution Box,

press the white plugs above each
connection into the Distribution
Box, while pulling the connector
pins out.

Note:
If the LED indicator
is not flashing green
or red, the 8A 
SLO-BLO fuse may

need to be checked.  This could
mean no power is going from
the battery to the Distribution
Box.
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It is suggested to do the following if a red LED is shown:

1) For a System using the standard battery only, you most likely need to
recharge or replace the battery.  

2) For a System using a solar panel, check the solar panel and regulator
connections. Check the output voltage on the solar panel (It should be
13V or more in order to recharge the battery).  If it is greater than 17V,
it may be an indication that the battery is disconnected. The battery must
be connected. 

3) For a System using an AC Charger, check the output voltage on the
charger.  It should be approximately 14.5V.

4) Pull the fuse out of the Distribution Box and check it.  Replace it, if it is
broken.  Replacement fuses are available from Solinst.

The LED will flash green if the error has been corrected.  If none of the above
actions correct the error, check all connections in the STS Remote Station.  If
the LED is still red, contact Solinst for further assistance (errors 3,4, or 5 may
have occurred).   



STS Gold Telemetry User Guide

Page 30

5.3 Connecting Dataloggers

Up to four Solinst dataloggers can be connected to one STS Distribution Box.
Dataloggers are connected to the Distribution Box using Reader Cables, which
connect to a Direct Read Cable threaded onto the datalogger.  The Reader
Cables are attached to the Distribution Box using a two-wire connection.  The
black and white circles shown at the connections on the Distribution Box
indicate which colour wire from the Reader Cable to connect.  Simply push the
connector pins on each wire into the appropriate opening.  The Reader Cables
are protected outside the enclosure using armored conduit.  Levelogger
installation options are discussed further in Section 6.2.

The dataloggers are programmed using STS Software. The software provides
the option of setting the dataloggers to record and store readings in their
internal memory, independent of STS operation.  This provides reliable back-
up data if the STS System were to fail, or it provides supplementary data if an
alarm condition is met and more data is desired.  Data can be downloaded
directly from the dataloggers.  Please refer to the Levelogger Gold User Guide
for data downloading instructions. 

Alternatively, dataloggers can be connected without programming an
independent recording rate.  The STS Controller will take a real-time reading
from the datalogger at the scheduled sampling interval.  

5.4 Power Source

STS Gold Telemetry Systems come standard with a 12V sealed lead-acid
battery.  The battery is connected to the “Battery” connection on the
Distribution Box, and connected to the positive and negative connections on the
battery.  The red wire is connected to the positive terminal on the battery, and
the black wire to the negative terminal.  You may have to remove covers on the
battery terminals before attaching the wires.  An optional battery connection
cable may also be used for a larger battery if desired.

There are also connections for an AC/DC battery charger or solar panel.
Setting up alternate power sources is discussed in Section 6.1.

Estimated battery life of the standard 12V battery is based on the frequency of
the Sample and Report Rates you set using the STS Software.  These estimates
are discussed in Section 6.1.

FFiigguurree  55--1122  RReeaaddeerr  CCaabbllee  (#108854)

Connect to
Direct Read Cable
with Datalogger
AttachedConnector Pins to 

Distribution Box

Note:
To remove the
Reader Cable
connector pins from
the Distribution Box,

press the white plugs above each
connection into the Distribution
Box, while pulling the connector
pins out.

Note:
It is required to use
the standard 12 Volt
battery that comes

with the system, even if using an
additional external power source.  
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RReemmoottee  SSttaattiioonn  
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5.5 Setting Up CDMA Modems

The standard CDMA modem used for STS Gold Telemetry Systems is the
IP-4200 Blue Tree CDMA Modem (CDMA-1xRTT Programmable Modem).
There are connections for the modem and modem power located and clearly
labeled on the Distribution Box.  The modem comes with a dual band dipole
antenna to be attached to the modem, using the SMA coaxial adaptor provided.  

An account must be set up with a local CDMA cellular service carrier.  You will
need to request a CDMA account with the packet data service option.  To
activate the modem, a password, user name, the Master Lock Code, Phone
Number (MDN) and the MIN/MSID are received from the CDMA service carrier.
The service carrier will ask for the modem ESN (number located on the bottom
of the modem).

BlueVue Device Manager software is required to configure the modem.  It can
be downloaded from the Blue Tree website at:

http://www.bluetreewireless.com/support/downloads/software

Install the software on the PC that will be used to program the modem.

Activating the Modem

The following are the steps required to activate the modem:

1) Ensure that the modem is connected to a power supply (the STS Remote
Station can be used with battery, Distribution Box and STS Controller all
connected, or direct AC/DC power).  Turn the modem on using the
Modem Control menu on the STS Controller. 

2) Connect the modem to the PC using the RS-232 cable provided.

3) Start the BlueVue Device Manager software on your PC.  Click on Tools
> Settings > Connection tabs.

4) Select Local Configuration.  Click on Serial port and select the the COM
port to which the modem is connected.  Click OK.  The Modem
Diagnostic page will automatically be displayed.

5) Receive Strength Indicator (RSSI) value should be > -100 dBm (shown on
top-right of screen, below signal strength icon.).  “Cleanness” of signal
(Ec/Io) should be > -15 dB (value found in the Advanced tab should be
divided by -2).

6) Click on File > Activation to display the Modem Activation page.

7) Enter the Master Lock Code, Phone Number, and MIN/MSID provided
by the service carrier.  If a MSID is not provided, assume it is the same as
the Phone Number.  Click Submit.

8) To confirm that the modem was activated correctly, go to File >
Diagnostic and ensure the Phone Number reported from the modem
matches the one provided by the carrier.  This may take a few minutes. 

Note:
The activation
instructions are based
on a RS-232 Serial
connection.  USB and

Ethernet can also be used, see
the User Guides on the Blue Tree
website for further instruction.

Note: 
Modem Activation
instructions are based
on Bell as the carrier.
The process may vary

with different carriers, visit:
http://www.bluetreewireless.com
/products/wireless/details.asp?id
=36
for “Quick Start Guides” specific
to each carrier.
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Note:
Setup instructions are
based on BlueVue
Device Manager
Software Version

1.7.3.  Before following these
instructions, check the version of
software you downloaded.  If
there has been an update, and
the version is different,  refer to
the User Guides provided on the
BlueTree website for the most up-
to-date instructions:
http://www.bluetreewireless.com/
products/wireless/details.asp?id=36
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WAN Settings

1) Click on File > WAN Settings. 

2) Enter “#777” as the Dial String.  The User Name and Password are
both entered as “X”, unless they are provided by the service carrier.
Select Always On.  Click Refresh.

3) On the Modem Diagnostic page, under  the Modem IP Information, the
WAN IP that the carrier has assigned will be displayed. 

Modem Configuration

1) Click on File > Configuration.  There are seven tabs in the Modem
Configuration page.  Figure 5-14 shows the General and Serial IP tabs
in the Modem Configuration page.

2) In the General tab, select “Serial IP” for the Operational Mode.  Click
Refresh.

3) In the Serial IP tab, under Destination 1, enter the Home Station IP
Address, the Port should be set at “49152” and the Protocol drop-down
menu should be set to “TCP”.  Flush Conditions, Serial IP Listening
Server and Destination 2 should be left blank. Click Refresh.

4) In the Serial Port tab, settings are applied to enable communication with
the STS Controller.  The following settings should be entered:

• Baud Rate: 115200 bits/second

• 8 data bits

• No parity

• 1 stop bits

• No Flow Control

• Do not check Disable RS-232 Sleep Mode and Ignore DTR.

When finished click Refresh. The Modem is now configured and ready to be
connected to the STS Distribution Box using the serial cable and power cables
provided.
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Note:
The IP Address
assigned to the
Home Station
computer can be

determined from your Internet
Service Provider, IT Department
or through accessing the
Command Prompt of the Home
Station PC.  

Go to Start > Run and enter
“cmd” (Windows XP) or
“command” to open the
Command Prompt.  Enter the
command “ipconfig”, and the
Home Station PC IP Address will
be displayed.

Select “Serial IP” as the
Operation Mode

Enter the Home Station 
IP Address

Enter “49152” as the Port

Select “TCP” as the Protocol
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5.6 Setting Up GSM Modems

The standard GSM modem used for STS Gold Telemetry Systems is the Digi
Connect WAN IATM.  There are connections for the modem and modem power
located and clearly labeled on the Distribution Box.  The modem comes with a
dual band dipole antenna.  

An account must be set up with a local GSM cellular service carrier.  To activate
the modem, you will require an IP Address supplied by the service carrier to be
assigned to the modem.

The following are the steps required to set up the GSM modem:

1) Attach the antenna to the modem.  

2) Insert the SIM card into the modem.

3) Connect the Ethernet Cable (null modem cable) from the modem to your PC.

4) Use the STS Remote Station, which includes the battery, STS Controller,
and Distribution Box to connect the modem to a power supply, or use
direct AC/DC power. Connect the modem to a power supply or turn the
modem on using the Modem Control menu on the STS Controller.  

5) After the connection has been established, you should see the message as
shown in Figure 5-16 at the bottom right of your PC screen.  Double-click
the network icon.

Note:
There is no software
required to configure
the GSM modem.
The modem must be
set up using an
Ethernet connection
to a PC.
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Note:
If more support
documentation is
required to setup the
GSM modem, please

visit: www.digi.com/support/
and select Digi Connect WAN IA
from the “Select a product” drop-
down menu to browse various
support documents.
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TM Digi Connect WAN IA is a trademark of Digi® International Inc.
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6) In the Local Area Connection Status window, the Support tab should
display the same Default Gateway and Subnet Mask, as shown in 
Figure 5-17.   The IP Address does not have to match, but it should begin
with 192.168.1.XXX (XXX is any number between 2 and 255), thus
matching the Default Gateway.  Close the window.
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7) Open your web browser and enter the IP Address “192.168.1.1” in the
URL address bar.  The main configuration menu of the modem will be
displayed.

8) Select “Mobile” under the Configuration menu.  

9) Make sure the Service Provider selected is correct, and the Service
Plan/APN is set to “internet.com”. Click on “Serial Ports” under the
Configuration menu and click on the Port that is available.  This should
be Port 1 by default.  

10) In the Port Profile window, select “TCP Sockets” and click Apply.

11) Make sure the Serial Port Configuration matches the screen in 
Figure 5-18.  Enter the IP Address provided by your Internet Service
Provider in the IP Address field.  The TCP Port should be set to “49152”.
When finished, click Apply.
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12) Select Basic Serial Port Settings to set up the communication 
parameters.  The following settings should be entered:

• Baud Rate: 115200 bits/second

• Data Bits: 8

• Parity: None

• Stop Bits: 1

• Flow Control: None

When finished, click Apply.  The Modem is now configured and ready to
be connected to the STS Distribution Box using the serial cable and
power cables provided.
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5.7 Setting Up Radios

The standard radio used for STS Gold Telemetry Systems is the Digi XTendTM

RS-232/RS-485 RF Modem, which operates at 900 MHz and has a line-of-sight
of 20 miles (30 km).  There are connections for the radio and radio power
located and clearly labeled on the Distribution Box.  The radio comes with a
6" half wave, (2.1 dBi) non-articulating antenna.

X-CTU Software is required to configure the radio.  It can be downloaded from
the Digi website at: http://www.digi.com/support/ by selecting “software” and
“X-CTU” from the drop-down menus.  Select “Diagnostics, Utilities, and MIBs”
to begin the software installation. 

The following are the basic steps required to configure the radio:

1) Install the software on the PC that will be used to program the radio.

2) Connect the radio to the PC using the RS-232 cable, and connect to a
power source.  The STS Remote Station can be used, with the STS
Controller, Distribution Box, and battery connected, or direct AC/DC
power.  Use the STS Controller, Modem Control menu, to turn the
modem on.

3) Launch the X-CTU Software.

4) Under the PC Settings tab, select the proper COM port.  

5) The following settings should be applied to configure the selected COM
port to enable communication with the STS Controller :

• Baud: 115200 

• No Flow Control

• 8 data bits

• No parity

• 1 stop bits

6) The Test/Query button is used to test the selected COM port and PC
settings.  If the settings are correct, you will receive a message saying
communication with the radio is okay.

7) On the Radio itself, ensure DIP switch 1 and 5 are on, all the rest are off.

The radio is now configured and ready to be connected to the STS Distribution
Box using the serial cable and power cables provided.

If further information regarding radio configuration and setup is required, the
X-CTU Software User Guide can be downloaded at:
http://www.digi.com/support/productdetl.jsp?pid=3352&osvid=57&tp=
4&s=316
The User Guide also includes details on conducting a range test between
the radio at the Remote Station and the radio at the Home Station.

Note: 
X-CTU Software is
required to configure
the radio.  It can be
downloaded at:

http://www.digi.com/support/
and type “X-CTU Software” into
the Product Keyword window.  

Note: 
The X-CTU Software
User Guide can also
be downloaded at:

http://www.digi.com/support/pr
oductdetl.jsp?pid=3352&osvid=5
7&tp=4&s=316 for further
information regarding radio
configuration and setup, and
instructions for conducting a
range test between radios.
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TMDigi XTend is a trademark of Digi® International Inc.
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5.8 Initialize Your System

After all settings in the STS Gold Software are programmed and all connections
are made at the Remote Station, the STS Controller is used to “Initialize” the
STS System.  Initializing the system applies all of the settings programmed in
the software, to the STS Controller and the attached dataloggers.  If all the
hardware components in the Remote Station and dataloggers are properly
connected, the STS System will begin operation, and data collection starts at
the programmed time.

The system can be initialized in the office or in the field, whichever suits the
application.  Initialization can be performed more than once as required.  The
STS System can be initialized in the office for a quick check, and again when it
is installed in the field.  With each initialization, the Home Station time is
synchronized with the Remote Station time of the STS Controller. 

Initialization Instructions

1) Once all physical connections are made in the STS Remote Station , the
“ON” button of the STS Controller is pressed to power-up the Remote
Station.  The LED on the Distribution Box should blink green to indicate
the Remote Station is configured properly, and the STS Controller main
menu should appear. 

2) Use the ‘Modem Control’ option on the STS Controller to turn the
modem off.  Disconnect the battery from the Distribution Box.  Wait a
few seconds, then re-connect the battery.  The LED on the Distribution
Box should blink green again.  Turn the STS Controller back on and use
it to power up the modem.  The green light on the modem should flash
to indicate that it is working.  

3) At the Home Station, shut down, then restart the STS Administration
Software and the STS Communication Agent.  After the software has
been restarted, the STS Administrator Screen should show the message
“Waiting for Update” in the Site Status field.

4) Before completing the initialization process, perform a station test to
ensure the Home Station and Remote Station are communicating
properly.  Use the ‘Station Tests’ option on the STS Controller to ‘Test
HS Connection’.  If the test is successful, begin the initialization process. 

Note: 
STS Gold
Administrator and
Communication
Agent Software must

be running on the Home Station
computer during the initialization
process.  The computer must not
be in sleep mode.

FFiigguurree  55--2200  SSTTSS  CCoommmmuunniiccaattiioonn  AAggeenntt  SShhoowwiinngg  aa  SSuucccceessssffuull  HHoommee  SSttaattiioonn  TTeesstt

Note: 
You can also use the
‘Station Tests’ option
on the STS Controller
to test the connection

of each datalogger and the
battery level of the remote station
before initializing.
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Note: 
After you select
“Initialize Home
Station”, the STS
Controller may ask if

you want to stop the dataloggers
from recording, if you have
previously set them to start
logging.  This is a precaution, as
the internal  battery will be used if
the dataloggers are set to record
independent of the STS System.

5) The initialization process is started by simply selecting “Initialize Home
Station” on the STS Controller menu.  STS Software must be running on
the Home Station computer during the initialization process, and the
computer must not be in sleep mode.  

6) The initialization process should only take a few minutes.  During the
process the status of the STS Controller will change from “Idle” to “Init”.
If initialization is successful, a message will be given and the STS
Controller status will change from “Init” to “Logging” or “FUT.ST”.  The
System will start collecting data at the specified time.  Figure 5-12 shows
a successful initialization process as it appears on the STS
Communication Agent.

See the STS Gold Remote Station Quick Start Guide, on the inside of the
STS NEMA 4X enclosure, for a complete view of the STS Controller  screens
as it appears during the station test and initialization process. 

FFiigguurree  55--2211  SSTTSS  CCoommmmuunniiccaattiioonn  AAggeenntt  SShhoowwiinngg  aa  SSuucccceessssffuull  IInniittiiaalliizzaattiioonn
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6  Configure Your Remote Station in Field

Ensure you have connected all hardware components in the STS Remote
Station.  To make sure everything is connected properly and working correctly,
you may want to initialize and test the system before you bring it to the field. 

The NEMA 4X enclosure can be mounted anywhere that suits your application.
Four bolts are provided with the STS System to connect the enclosure to a user-
supplied bracket and mast, or any support that suits your needs.    

Radio Location Considerations

When using radio communication, you must take extra care when locating 
the STS Remote Stations.  RF Radios communicate with each other via 
“line-of-site”. They must be able to “see” each other in order to have effective
communication.  The RF path between radio antennas should not be through
trees or parallel or perpendicular to the sides of flat buildings.  An more sensitive
antenna may be required to increase signal strength in some applications. 

A range test can be performed prior to installation, between the Home
Station radio and the Remote Station radio.  The Range Test Application is
included in the X-CTU Software used to setup the radios.  Instructions for
conducting the test can be found at:
http://www.digi.com/support/productdetl.jsp?pid=3352&osvid=57&tp=4&s=316
You will require a serial loopback adaptor for the radio at the Remote Station.

Cellular Signal Strength

Received Signal Strength Indicator (RSSI) is the measure of RF signal strength
between the Remote Station modem and a base station, expressed in dBm.
The signal strength should be no less than -100 dBm (considered weak
coverage), -50 dBm is considered to be full signal strength.  

A site survey can be performed prior to installation, to determine the signal
strength on site.  This can be done using a cellular device.  There is a useful
document prepared by wpsantennas.com outlines how to perform a site
survey with various cellular devices:
http://www.wpsantennas.info/pdf/testmode/FieldTestModes.pdf

You can determine the RSSI for the CDMA modem using the BlueVue Device
Manager Software.  When the modem is connected to a PC, with the
software running, the top right corner of the software window will display the
RSSI value.  If the software is downloaded to a field laptop, you can
determine the signal strength on site.

For GSM modems, a general indication of the signal strength can be determined
from the number of LEDs that light up on the modem:

0-1 LEDs (-101 dBm or less) = unacceptable coverage

1-2 LEDs (-100 dBm to -91 dBm) = weak coverage

2-3 LEDs (-90 dBm to -81 dBm) = moderate coverage

4 LEDs (-80 dBm or greater) = good coverage

Note: 
The radio used for the
STS System has a
line-of-site of 20 miles
(30 km).



Sample Rate Report Rate Battery Life

Every 5 Minutes Every  Hour 30 - 40 Days

Every 15 Minutes Every 6 Hours 4 - 6 Months

Every 5 Minutes Every 12 Hours 5 - 7 Months

Every 15 Minutes Every 24 Hours 12 - 14 Months

Every 15 Minutes Every 7 Days 13 - 15 Months
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The battery life estimates assume the Controller and Modem are NOT set to be
“Always On”.  If used for more frequent data collection, with both Controller
and Modem “Always On”, the battery life will be less than 2 days.  (A larger 60
AHr battery would last about 6 days)  Therefore, external power or a solar panel
is required for continuous recharging of the battery.

External power and charge accessories are available for the STS Remote
Station.  A solar power connector package is available from Solinst, to be used
with a user supplied solar panel.  The package includes an External Power Cable
to attach to a user-supplied solar panel and a Regulator, to handle the current
from the solar panel. (Figure 6-5 shows connection for the solar power
connector package).  An AC Power/ Battery Charger Assembly is also available
from Solinst.  The Assembly comes with a battery charger and cables for
connection to the ‘Regulator” terminal on the Distribution Box and to an AC
power source to provide current for battery charging (See Figure 6-2). 

Signal strength can be increased by adding an optional antenna, or by simply
relocating the Remote Station to an area with maximum signal strength on site.

Optional Antennas

Solinst has an optional antenna available for use with CDMA, GSM, and Radio
modems, if greater range is required.  In North America the CDMA/GSM
antenna operates in 824-896 MHZ and 1850-1900 MHz frequencies.  This
dual band, omnidirectional antenna is a unity gain, 1/4 wavelength, and
connects to the modem via a 12' cable and SMA connector.  An optional 900
MHz 5 dBi antenna is also available for the Radio.  Antennas mount using a
mini magnet on the base, outside the enclosure.  In order to accommodate the
antenna cable, the NPT plug on the top of the enclosure will need to be
removed (using an Allen Key), and a weathertight fitting, supplied by Solinst,
threaded in its place.  

6.1 Optional Power Sources

STS Gold Telemetry Systems come standard with a 12 Volt sealed lead-acid
battery, which only requires one connection to the Distribution Box.  The life-
time of the battery varies depending on the frequency of your Sample and
Report Rates. The following are estimates based on the standard 12V/12Ah
battery, with four dataloggers connected to the System.  With only one
datalogger connected to the Distribution Box, battery life estimates will be
approximately 10% longer. 

FFiigguurree  66--11  WWeeaatthheerrttiigghhtt  NNPPTT
FFiittttiinnggss  (#108830)

Note:
It is recommended to
use the standard 12
Volt battery that
comes with the
system, even if using
an additional external
power source.  
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FFiigguurree  66--33  SSttaannddaarrdd  RReemmoottee  SSttaattiioonn  SSeettuupp

Levelogger
Reader
Cable

STS Controller
Cable

Battery Cable

Modem
Power Cable

Modem
Serial Cable

Figure 6-3 shows the standard connection to the 12V sealed lead-acid battery.
If you choose to use a larger battery, a larger cable is available from Solinst
(#108981).

FFiigguurree  66--44  SSoollaarr  PPoowweerr  CCoonnnneeccttoorr  PPaacckkaaggee  (#108988)

Connection to
Solar Panel

Connection to
Distribution Box

Regulator

Connection to
Distribution Box

External Power
Cable

NPT Fitting

FFiigguurree  66--22  BBaatttteerryy  CChhaarrggeerr  AAsssseemmbbllyy  (North American #108848)

Connection to
Regulator Input on

Distribution Box

Battery Charger
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Note:
If using a solar panel,
you must ensure
output is a minimum
of 13V open circuit,

in order to effectively recharge
the 12V battery.  

Note:
The Solar Panel
Regulator supplied by
Solinst must be
connected to the

Distribution Box.  It is
recommended that you select a
solar panel without a regulator.

Figure 6-5 shows connections for a solar panel.  

External
Power Cable

Levelogger
Reader
Cable

STS Controller
Cable

Battery Cable

Modem
Power Cable

Modem
Serial CableRegulator

Cable

FFiigguurree  66--55  RReemmoottee  SSttaattiioonn  SSeettuupp  wwiitthh  CCoonnnneeccttiioonnss  ffoorr  aa  SSoollaarr  PPaanneell

The solar panel is user-supplied.  The panel must output a minimum of 13V
open circuit in order to effectively re-charge the standard 12V battery.  As a
guideline, the solar panel should be at least 15 Watts.  Higher wattage panels
are also suitable, as a Regulator is supplied as part of the solar panel connector
package provided by Solinst.  The Regulator supplied must be used, even if the
solar panel you are using has a built-in regulator.  Therefore, when choosing a
suitable solar panel, it is recommended to use one without a built-in regulator.
Below are more guidelines for a proper solar panel: 

Generator Connector:  Max V in = 35VDC, Max Current = 3A

Regulator Connector:  Max V in = 35VDC, Max Current = 3A

Max V out = 10-16VDC, Max Current = 3A

Battery Connector:  Max V in/out = 7-15VDC, Max Current = 3A

Modem Connector:  V Modem = Battery V in/out, Max Current = 3A      
(5A fused) 

To accommodate the External Power Cable through the enclosure,  the second
NPT plug on the base of the enclosure will need to be removed (using an Allen
Key), and a weathertight fitting, supplied by Solinst, threaded in its place.  
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6.2 Levelogger Deployment

Many options exist for installation of the Levelogger, but essentially these
installation methods can be classified into two broad categories: free suspended
or fixed installations. 

1) In free suspended installations, the Levelogger is hung via Direct Read
Cable from a well cap. 

2) In fixed installations the Levelogger is fixed in place by a compression fitting,
a clamping mechanism or simple metal straps, with a Direct read Cable
connected.

Prior to commencing the discussion of installation techniques several general
points related to Levelogger installation should be made. First, it is
recommended that the Levelogger be installed in a vertical orientation.
However, inclined or horizontal installation is acceptable. The level sensor in the
Levelogger is indicated by the machined line about the body of the datalogger
just above the pressure access holes. The pressure transducer is oriented in a
plane normal to the long axis of the body and detects pressure directed along
the plane of the long axis (Fig 6-6).  In vertical orientations, the sensor detects
pressure above the pressure transducer line, where as in non-vertical
orientations, the pressure zero point is proportional to the angle of inclination. 

Care should be taken to avoid dropping the Levelogger against a hard
surface.  Further, the pressure transducer can be damaged if the datalogger
is over-pressurized by submergence greater than its level range. The
Levelogger is warranted to pressures up to 150% of its full scale level
range, however accuracy can not be guaranteed beyond its full scale.

Other important considerations when installing the Levelogger in pressurized or
intermittently pressurized locations such as pressure vessels, pressurized pipes,
pulse flow conditions, drop structures or near hydraulics works, is to keep in
mind the potential effect of water or steam hammer and hydraulic jump. Water
hammer is caused by an abrupt alteration of flow direction resulting in pressure
surges. Steam hammer occurs when steam enters a cold pipe partially filled with
water.  The hammer effect has the potential to significantly increase hydraulic
pressure possibly exposing the pressure sensor to pressures beyond its
maximum rating.  Hydraulic jump is a phenomenon that occurs when water is
‘lifted’ or ‘ramped’ by velocity or flow obstructions.  Hydraulic jump causes
turbulence and creates non-representative head conditions in the water column.
Care should be taken to avoid logger installation at points susceptible to
hydraulic jump. 
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Direct Read Cable Assembly Installation

The dataloggers are installed using a Direct Read Cable threaded onto a Reader
Cable, which is connected to one of four terminals on the STS Distribution Box.  

One of two NPT plugs in the base of the Remote Station enclosure will need to
be removed (using an Allen Key), a weathertight fitting threaded in its place. The
Reader Cables are fed through armored protective conduit (supplied with the
STS System) and into the base of the Nema 4X Enclosure through the
weathertight fitting.  The two wires at the end of the Reader Cable are inserted
into the labeled terminals on the STS Distribution Box.  A nut is threaded onto
the fitting to anchor and seal the protective armored conduit to the STS
enclosure.  A Direct Read Cable with the datalogger connected is threaded onto
the other end of the Reader Cable.

Specially designed Direct Read Wellheads can be used to deploy Leveloggers in
a well. The Direct Read Cable threads to the Levelogger, while the socket at the
opposite end of the Cable fits into the Direct Read Wellhead.  The Reader Cable
threads onto the Direct Read Cable at the wellhead.  A hole may be drilled into
the side of the wellhead and a fitting threaded in the hole.  Reader Cables are
fed through the fitting, and a nut threaded to the fitting to seal the other end of
the protective armored conduit to the wellhead.  

Contact Solinst directly for more details regarding specially designed wellheads.

FFiigguurree  66--77  
LLeevveellooggggeerr  CCoonnnneeccttiioonn  ttoo  SSTTSS
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Barologger Installation

The Barologger is a Levelogger with a small range of 4.92 ft (1.5 m) adequate
to monitor the fluctuations that occur in barometric pressure. The Barologger’s
readings are used to barometrically compensate Levelogger readings. Typically,
Barologger readings range from 1 – 3.3 ft (30 – 100 cm) when the Barologger
is programmed with its operating altitude. Failure to input the correct altitude
will result in incorrect readings and may cause the pressure transducer to go out
of range. It is strongly recommended that the altitude input be accurate 
to ≤10 m. When the Barologger is programmed at its operating altitude, its
readings can be used to directly compensate for barometric pressure, the
readings of any Levelogger programmed at the Levelogger’s operating altitude.
As a rule of thumb, a Barologger can be used to compensate all the Leveloggers
in a 20 mile (30 km) radius.

To monitor barometric pressure correctly, the Barologger should never be
submerged. In well installations, it is recommended that the Barologger be
suspended in one of the monitored wells above the high water point (Figure
6-9).  For best reading accuracy, the Barologger should be installed in a
similar thermal environment to that of the Levelogger. In groundwater wells,
the Barologger should be suspended beyond the frost line and deep enough
to avoid large temperature fluctuations. In surface water applications, the
Barologger is best deployed in a dry well – a well embedded in the bottom of
the water body, but sealed at the base from water entry and vented to the
atmosphere. If a dry well cannot be installed, the Barologger can be installed
on a float in the stilling well. 

Note:
The Barologger
Gold should not
be used to
monitor water, as

the internal mathematics for
temperature compensation
are based on air rather than
water.

FFiigguurree  66--99  LLeevveellooggggeerr
aanndd  BBaarroollooggggeerr  iinn  WWeellll
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6.2.1 Installation in Extreme Thermal and Marine Environments

Freezing or High Temperature Conditions

Levelogger installation at submerged depths that may be at risk of freezing
during the monitoring session is not recommended without taking adequate
precautions to avoid transducer damage. When water freezes it expands
approximately 9% by volume. 9% expansion can equate to extreme pressure as
demonstrated in Example 6.1. Therefore, solid freezing has the potential to
damage the pressure transducer, which is rated to withstand up to 150% of its
depth fluctuation range. Pressures beyond this threshold may damage the
transducer. With certain precautions, the Levelogger can be used in freezing
liquid environments. If monitoring shallow water bodies or groundwater zones
susceptible to freezing, the easiest way to avoid transducer damage is to lower
the transducer to a point in the water column below the frost line or ice
formation depth. In water bodies such as shallow streams, wetlands or ponds
where freezing may penetrate to the bottom, install the Levelogger in a vented
stilling well imbedded into the bottom of the water body beyond the frost line.
In cases where the above noted precautions cannot be taken and the Levelogger
must be installed in the freezing zone, it is recommended that the datalogger be
placed inside two elongated silicon, rubber or latex balloons, the balloons be
filled with a non-toxic, non-corrosive anti-freeze solution and sealed
(Figure 6-10). Place the balloons in a section of perforated, 1.25" (30 mm) ID
pipe and install the datalogger in the monitored water. The antifreeze solution
will protect the Levelogger from ice expansion at the pressure transducer, yet
transmit any pressure fluctuations that occur. Please note that a similar
installation protection can be used when the Levelogger is monitoring liquids
which are incompatible with its wetted materials. The operating temperature
range for Leveloggers is -20° - 80°C (-4° - 180°F).  At the opposite end of the
thermal scale, exposing the Levelogger to temperatures beyond 80°C may
damage the thermistor and otherwise affect the Levelogger.

Example 6.1 Solid Freezing Effects

The pressure exerted by the physical expansion or ice crystallization process
on a retaining or enclosing contact surface is related to the temperature
gradient over which the process occurs.  For example, liquid freezing at -22ºC,
can create expansion pressures of 22 kg/cm2 or 313 psi or the equivalent of
721 ft or 220 m water column depth.

FFiigguurree  66--1100
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Marine or Brackish Installations

When installing the Levelogger in salt or brackish water or in a liquid having a
specific gravity (density) different than fresh water, the density difference is
compensated for by checking the Density Adjustment checkbox in the
Levelogger Information window and inputting the density of the monitored fluid.
See Section 3.3 for details in compensating the Levelogger for fluid density
differences. 

The Levelogger Gold can be used for monitoring in salt or brackish water.  If
using a Levelogger Gold in a continuous salt/brackish monitoring scenario, the
stainless steel body of the datalogger can be protected in a manner similar to
the freezing protection method described earlier in this Section. The Levelogger
can be placed in balloons and the balloons filled with non-corrosive/ non-toxic
fluid. As pressure changes, the fluid encasing the datalogger will transmit the
pressure differential to the datalogger’s pressure transducer.  Care must be taken
in the selection of the balloon material or filling fluid such that the balloon
material prevents diffusion of salts across the concentration gradient or that the
filling fluid is comprised of polymeric molecules too large to diffuse out of the
balloon material.

6.2.2 Rainlogger Installation

The rain gauge connected to the Rainlogger is supplied by the customer and is
a reed-switch type gauge most commonly known as a tipping-bucket rain gauge.
The rain gauge connector is 3-pin (Figure 6-11) and connects to the 3-pin cable
supplied with the Rainlogger. Longer cables up to 30 m (100 ft) can be supplied
when the Rainlogger is ordered. 

The connector cable has a blue and brown wire, which are connected by
splicing to the tipping bucket device. As the tipping bucket is just an electrical
switch, it does not matter to which terminal on the tipping bucket the blue or
brown wire is connected. Longer, exposed cables should be protected from
rodents and vandalism by cable armoring or installation within electrical conduit.
The other end of the Rainlogger is connected to a Direct Read Cable, which is
threaded to the STS Reader Cable, and is connected to the STS Distribution
Box.

Direct exposure to rainfall should be avoided, and the Rainlogger should not be
submerged. When logging, the logging lamp on the Rainlogger will flash every
log interval.

3 Pin Rain
Gauge Connector

FFiigguurree  66--1111
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The data will be displayed in a table at the top of the window, the bottom
portion of the window will show the data graphed.  Data from each datalogger
is shown in a separate tab (identified by serial number), Remote Site Data,
including battery voltage is also displayed in a separate tab. 

7 Accessing Your Data

Data received in each report from the STS Controller is placed in an Access
database on the Home Station computer.  New data is appended to the existing
database.  The program will save data downloaded to the following default
directory:  <C:\Program Files\Solinst\STS_Gold\db>
STS Gold Software can be used for a quick check of the latest readings.  Data
can also be exported using the STS Software as .lev or .csv files for use in other
programs.

To view data from a specific site, click on the STS
Administrator screen.  Select the site from the list that opens and click OK. 

FFiigguurree  77--11
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7.1 Graphing Options

Click the Graph Option icon to open the Graph Option Dialog. The Graph
Dialog is shown in Figure 7-3. 

The Line Option is used to adjust the style and colour of the line in the graph
for each channel. The user can also select the shape of the data marker or
remove the data marker.

The Title and Axis Option is used to enter the title of the graph and change
the Y axis label or user selected scale. Check the Best Fit box to enable the
software to determine the best fit scale. If the Best Fit box is not checked, the
user has to enter a maximum and minimum value of the selected channel. The
X axis is logging time.

FFiigguurree  77--33  GGrraapphh  OOppttiioonn  DDiiaalloogg
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7.2 File Export 

Data can be exported in *.csv (comma separated value) or *.lev  (Levelogger) file
formats by clicking “Export Data” while viewing the site data. The *.csv  file
format is supported and can be imported by most spreadsheet programs,  *.lev
files can be imported by Levelogger Software, where data compensations are
performed. 

Clicking will display a drop down menu where you can select
to export as a *.csv file or *.lev file.  

Exporting as a *.csv file will export all of the data from the selected site.  You
can save this file where you choose and give it a unique file name.

Exporting as a *.lev file, allows you to select a specific Levelogger File.  Choose
the desired file from the list.  The file name will include the datalogger serial
number, and can be saved in a Folder of your choice.  This file can be imported
by the Levelogger Software, where barometric and other compensations are
performed.

FFiigguurree  77--44  
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7.3 Data Compensation

After exporting a *.lev file from the STS database, the file can be imported into
Levelogger Software where data compensation can be performed.  

Open the imported files in the Levelogger Software, and click on the Data
Compensation icon, to start the data compensation wizard application.  

In the first window of the wizard, the user identifies the currently opened file
type. There are two file types: Barometric files (data that is retrieved from a
Barologger) and Submerged Levelogger files (data that is retrieved from 
Levelogger Gold or Levelogger Junior).  After the selection of the file type, click
Next and the Data Compensation selection window will open. 

There are four data compensation options available: Barometric
Compensation, Manual Data Adjustment, Density Adjustment and
Barometric Efficiency.

• Barometric Compensation requires the Barometric file and the
submerged Levelogger file and simply involves subtraction of the
barometric reading from the Levelogger reading. If there is an
inconsistency of the time stamp between the Barometric file and the
Submerged Levelogger file, a linear approximation on the barometric
data will be performed.

• Manual Data Adjustment allows the user to enter a manual water level
measurement as a reference datum or field zero, which all Levelogger
water level readings can then be adjusted to.  If the reference datum is
above water level (e.g. top of well casing), the datum must be input as a
negative value.  If the reference datum is below water level (e.g. sea level),
a positive value is input. The date and time of measurement of the
reference datum must be recorded and input to complete the adjustment.
The program computes a correction factor based on the time-stamped
reference datum, and adjusts all the data in the selected file after
barometric, density, and other data compensations are performed. 

FFiigguurree  77--77  DDaattaa  CCoommppeennssaattiioonn  WWiinnddooww  --  CCoommppeennssaattiioonn  SSeelleeccttiioonn

Note: 
STS Software does
not include a
Barometric
Compensation

Wizard.  STS data files can be
exported for use in Levelogger
Gold Software, which has an
automated compensation process.

For further instruction on data
compensations, see the
Levelogger Gold User Guide.   
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• Density Adjustment corrects the range of the level channel in the data
file based on a user input adjustment of fluid density.  The density range
can be set from 0.90 to 1.10.

• Barometric Efficiency Adjustment is used to proportionally adjust
Barologger data in relation to a particular Levelogger. Barometric
efficiency is often expressed as a percentage or proportion. The input
field is proportional and has a default value of 1.00. For more
information about Barometric Efficiency, see Section 11.1.3. 
The barometric efficiency can be set from 0.01 to 3.00.

The compensated data will be saved in a new *.lev file. The default file
name will be the <Submerged Levelogger file name> with the word
<compensated> added to the file name prefix. Alternatively, the user can
name the compensated file. Do not change or delete the file extension.
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8 Remote Firmware Updates

STS Gold Software allows you to update the Remote Station firmware from
your Home Station Computer.  The Remote Station STS Gold Controller has
been designed with firmware that is easy to update whenever useful new
functions or other improvements become available. 

Under the File menu on the STS Administrator Screen, choose ‘Firmware
Upgrade’.  The STS Firmware Upgrade Window will display. 

Note: 
If you have registered
your STS Gold
Software at:

www.solinst.com/Downloads/,
you will receive email notifications
when new firmware is available.
If not, it is recommended you
routinely check for new firmware
manually. 

The latest firmware version is automatically retrieved from the Solinst server.
Each Remote Station and its firmware version will be listed.  Check the Sites
that need to be updated, and click Apply.

You can also go to: www.solinst.com/Downloads/ and download the firmware
version to your Home Station Computer.  Copy the file location and enter it in
the Firmware File Location Bar.  Check the Sites to be updated, and click Apply.

FFiigguurree  88--11

FFiigguurree  88--22  SSTTSS FFiirrmmwwaarree  UUppggrraaddee  WWiinnddooww

Note: 
The new firmware
will be uploaded to
the Remote Station
STS Gold Controller,

the next time the Remote
Station reports to the Home
Station. 

Note: 
If you are using
Radio
communication, and
your Home Station

computer is not connected to the
internet, you can download the
firmware file onto another
computer and copy it onto the
Home Station computer.  Enter
the file location in the Firmware
File Location Bar. 
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FFiigguurree  88--33  SSTTSS  CCoommmmuunniiccaattiioonn  AAggeenntt  aanndd  SSiittee  SSttaattuuss  BBaarr

The Site Status Bar on the STS Administrator screen should indicate the
upgrade is being performed.  Also, the STS Communication Agent will display
the progress of the upgrade and notify when it is complete (see Figure 8-3). 

The new firmware will be uploaded to the Remote Station STS Gold Controller
the next time the Remote Station reports to the Home Station.
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9  Maintenance

It is suggested that battery re-charging be done on regular scheduled intervals,
based on the battery  life estimates shown in Table 6-1.  Recharging is especially
important in the fall, if the winter temperatures are cold.  Replace existing lead-
acid batteries every 3-5 years. 

System Diagnostics

Each data report from an STS Controller to the Home Station, includes System
information on battery level, signal strength, and datalogger status.  This
information can help maintain the System without having to visit the site.  It can
also help determine the cause, if a data disruption does occur.  

If the Remote Station battery goes below 9 Volts, an alarm will be sent to a
selected email address, if the Alarm Setup section in the STS Gold Software is
used. (See Section 3.4).
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Glossary of Terms

CDMA (Code Division Multiple Access) - A form of wireless communication, in
which data is sent over multiple frequencies simultaneously, optimizing the use
of available bandwidth.  800 MHz - 1.9 GHz.  

Dynamic IP Address - A type of IP address that is temporarily assigned by a
service provider, and can change as frequently as every hour.

GSM (Global System for Mobile Communications) - A form of wireless
communication, in which data is digitized and compressed, and sent down a
channel with two other streams of user data, each in its own time slot.
900 MHz or 1800 MHz.

TCP/IP (Transmission Control Protocol/Internet Protocol) -  Is the basic
communication protocol of the Internet.

IP Address - A unique identifier given to each IP network device. 

Line of Sight - Between two radios communicating, the antennas must be able
to “see” each other.  There can be no interference from trees or buildings.

MDN (Mobile Directory Number) - Ten-digit telephone number assigned to your
modem , including the area code (also just referred to as phone number) 

MIN/MSID (Mobile Identification Number/Mobile Station ID) - A number given
by a wireless operator, to identify a mobile user.   

RF - Radio Frequency.

RSSI (Received Signal Strength indicator) - is the measurement of RF signal
strength between the remote modem and a base station.

SIM (Subscriber Identity Module) - Stores data for GSM modems and phones,
such as user identity, location, phone number, network, etc.

SMA (SubMiniature version A) - A coaxial Radio Frequency connector.

SMS (Short Message Service) - A communication protocol allowing short text
messages sent between mobile telephone devices.

SMTP (Simple Mail Transfer Protocol) - The standard protocol for e-mail
transmissions across the Internet.

Static IP Address - A type of IP Address that does not change over time. 

WAN (Wide Area Network) -  A geographically dispersed telecommunications
network.

Note:  Some definitions were sourced through Wikipedia.
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Specifications Radio Digital Cellular (CDMA & GSM) Satellite

Why Use?
• smaller applications
• closed loop network at any location 

in the world

• cellular coverage available
• topography not suitable for radio
• send data over the Internet

• too remote for cellular
• send data over the Internet

System
Differences

• free airtime, no long distance fees
• you control the network
• scheduled data transmission times
• medium power needs

• monthly carrier fees
• no scheduling conflicts for data 

transmission
• low power needs

• satellite service available anywhere
• no scheduling conflicts for data 

transmission
• larger power needs

Suggested
Applications

• monitoring mine sites
• agricultural studies
• landfill supervision
• golf course management

• flood and stormwater management
• watershed management
• drought monitoring

• glacial melt monitoring
• hard-to-reach, isolated areas

Remote Station Support
• 900 MHz radio
• 20 mile (30 km) line of site
• 115200 bits/sec

• CDMA or GSM IP enabled modem
• dynamic IP Address
• 115200 bits/sec

• IP enabled modem
• dynamic IP Address
• 115200 bits/sec

Home Station Support • 2nd Radio required with RS232 connection
• STS Software

• static IP Address
• no extra hardware
• STS Software

• static IP Address
• no extra hardware
• STS Software

Antenna
6" (15 cm) half wave, (2.1 dBi) non-
articulating Dual Band Dipole Included

Optional Antenna 896-960 MHz Dual Band, Omni Directional N/A

No Data Hosting Fees

Remote Firmware Upgrades

Remote Diagnostic Reporting

Power 12V sealed lead-acid battery

Clock Accuracy +/ - 1 minute per year

Operating Temperature -20 to 50˚C

Enclosure Weatherproof NEMA 4X (fiberglass)

External Power and
Charge Accessories

• Solar power connection package (for user supplied solar panel)
• AC power/battery charger assembly

Appendix i) Technical Specifications
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Digi XTend RS 232/RS-485 RF Modem

Operating Frequency: 902 - 928 MHz

Operating Range: 20 miles (30 km)

Operating Temperature: -40˚C to 85˚C

Data Rate: 115200 bps

Data Connection: Female DB-9

Power Output: 1 mW - 1 W

Transmit Current: 900 mA

Receive Current: 110 mA

Idle Current: 17 mA

Enclosure: Anodized Aluminum

Size: 2.75” x 5.50” x 1.13” (6.99 cm x 13.97 cm x 2.86 cm)

Weight: 0.61 lb (200 g)

Digi Connect WAN IA GSM Modem

Operating Frequency: 900/1800 MHz

Operating Temperature: -30˚C to 70˚C

Data Rate: 115200 bps

Data Connection: Male DB-9

Idle DC Power Consumption: 1.2 W

Max DC Power Consumption: 3.4 W

Size: 3.35” x 5.25” x 0.97” (8.51 cm x 13.33 cm x 2.47 cm)

Weight: 1.0 lb (450 g)

Blue Tree IP 4200 CDMA-1xRTT Programmable Modem

Operating Frequency: 800/1900 MHz

Operating Temperature: -40˚C to 85˚C

Data Rate: 115200 bps

Data Connection: Female DB-9

Peak Output Power: 0.327 W @ 1900 MHz, 0.247 W @ 800 MHz

Transmit Current: 182 mA (average) 

Idle Current: 62 mA

Enclosure: Extruded Aluminum

Size: 6.5” x 4.0” x 1.6” (16.6 cm x 10.0 cm x 4.0 cm)

Weight: 1.1 lbs (498 g)

More Technical Specifications for this modem can be found at:
http://www.digi.com/products/wireless/xtend.jsp

More Technical Specifications for this modem can be found at:
http://www.digi.com/products/cellulargateways/digiconnectwanfamilyspecs.jsp

More Technical Specifications for this modem can be found at:
http://www.bluetreewireless.com/products/wireless/details.asp?id=36




